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Введение 

 
HFSS v. 13 - это программа расчета электромагнитного поля для 

проектирования СВЧ структур, имеющая несколько алгоритмов расчета [1]. 
Последняя версия программы HFSS выполняет расчеты методом конечных 
элементов в частотной области, переходные процессы, использует метод 
интегральных уравнений, а также гибридный подход: метод конечных 
элементов + метод интегральных уравнений. 

Каждый метод в HFSS реализован в виде программы, в которой нужно 
создать исследуемую структуру, задать параметры материалов и 
рассчитываемые характеристики. После этого HFSS генерирует сетку для 
решения задачи методом конечных элементов. В программе HFSS сетка 
генерируется адаптивно в зависимости от особенностей структуры и 
особенностей поля в ней.  

В HFSS версии 13 сделан большой шаг вперед по сравнению с 
предыдущими версиями программы, разработанными в фирме Ansoft. В ней 
выполнены модификации алгоритмов генерации сетки и алгоритмов расчета. 
Новый быстрый и устойчивый алгоритм TAU генерирует более 
качественную тетраэдральную сетку.   

Формирование системы уравнений, обеспечивающее смешанный 
порядок следования ее блоков, а также произвольная декомпозиция области 
решения,  позволяют реализовать в  HFSS возможности 
высокоэффективного расчета (High-Performance Computing HPC). 
Программа черчения трехмерной модели была улучшена операциями типа 
вставки и переноса  двумерных и трехмерных моделей (imprinting), а 
интерфейс был модифицирован для лучшего использования и 
автоматизации. 
     HFSS рассчитывает широкий спектр внешних параметров СВЧ устройств 
и антенн, к которым относятся электрические и магнитные поля, токи, S-
параметры, ближнее и дальнее поле, а также может рассчитать переходной 
процесс и временнЫе изменения электромагнитных полей [2-4] 

Разработчики могут быть уверены в точности HFSS при 
проектировании устройств, которые включают  внедряемые пассивные и 
активные  "чипы" и моделировать, таким образом, активные антенны, 
многослойные интегральные схемы СВЧ, ВЧ/СВЧ  компоненты и 
биомедицинские устройства (рис. В.1, В.2).  
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                    Новыми свойствами в  HFSS 13.0 являются:  

• Новый, устойчивый метод разбиения на тетраэдры;  
• Реализация криволинейных элементов; 
• Расчет производных изменения характеристик при варьировании 

переменных;  
• Чтение файлов ACIS R19. 2  (19 версии); 
• Улучшенная связь с программой ANSYS DesignXplorer; 
• Расчет переходного режима;  
• Реализация гибридного метода конечных элементов  и метода 

интегральных уравнений; 
• Интеграция с общей платформой ANSYS;  
• Многопроцессорное уплотнение сетки разбиения; 
• Улучшенная постпроцессорная обработка данных;  
• Вывод широкополосных характеристик исследуемых структур.  

 

 
Рис. В.1. Модель пятизвенного волноводного фильтра, с рассчитанным в 

комплексе ANSYS температурным распределением 
 
   Существенно также, что к программе  HFSS -13 прилагается ряд примеров, 
которые можно использовать в качестве шаблонов, и которые показывают 
новые возможности программы. 
     HFSS использует в качестве основного инструмента решения 
электродинамических задач метод конечных элементов.  В этом методе весь 
объем разбивается на тетраэдры, внутри которых поле представляется в виде 
объемных базисных функций с неизвестными коэффициентами, которые 
находятся из решения системы линейных уравнений. 

В HFSS версии 13  добавлен программный модуль HFSS-IE, 
реализующий  метод интегральных уравнений, который использует 
двумерные базисные функции, описывающие токи  на поверхностях, в том 
числе  объектов с конечной проводимостью, что позволяет описывать 
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диэлектрические и металлические объекты с потерями. Этот метод часто 
называется методом моментов (МОМ).  Модуль  HFSS-IE разработан для 
моделирования больших излучающих структур. Этим методом в HFSS 
можно выполнить: 
• расчет радиолокационного поперечника рассеяния (Radar Cross Section 
RCS); 
• расчет антенны, расположенной на большом объекте, например на 
автомобиле; 
• расчет коэффициента связи между удаленными антеннами; 
• расчет электромагнитной совместимости; 
• расчет многопортовых СВЧ структур и антенн. 

       Метод интегральных уравнений в силу особенностей формулировки 
граничной задачи рассчитывает поле в бесконечном пространстве [5,6]. 
Поэтому он не нуждается в поверхностях, моделирующих поглощение поля 
излучения: radiation boundary, perfectly matched layer и т.д. Это избавляет 
пользователя программы от необходимости окружать излучающий объект 
замкнутым воздушным объемом (box) с условиями излучения на 
поверхностях. Также появляется возможность расчета антенн, 
расположенных над поверхностью земли с конечной проводимостью.  

     Этот метод работает в  стандартном интерфейсе HFSS. Перечислим его 
особенности:  

• излучающие (открытые) объекты описываются без воздушного бокса; 

• имеется возможность анализировать объекты, содержащие бесконечные 
плоские структуры, в том числе бесконечные экраны и т.д.; 

• программа допускает использование дискретных источников возбуждения 
и источников в виде падающих плоских волн;  
• программа поддерживает расчет в диапазоне частот, задаваемый в виде 
дискретных точек и в режиме интерполяции;  

• программа производит расчет ближнего и дальнего полей; 

• для структур с большими электрическими размерами HFSS-IE использует 
методы сжатия разряженной  матрицы, ускоряющие вычислительный 
процесс; 

• возможно разделение модели на составные части, анализируемые с 
помощью различных методов расчета. 

В HFSS 13 легко реализуется вставка проектов разных типов друг в 
друга. Чтобы вставить проект HFSS или HFSS-IE достаточно кликнуть  Insert 
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HFSS Design  или  Insert HFSS-IE Design и новый проект появится в дереве 
проекта под именем HFSSDesignn или HFSS-IEDesignn, где  n - номер 
добавленного проекта в порядке его появления в общем проекте.      В проект 
можно включить больше, чем одну установку на решение. Причем можно 
задать методы решения HFSS или HFSS-IE, добавляя конструкции, 
анализируемые разными методами. Каждая установка решения включает 
следующую информацию: 

• общие данные о решении;  
• параметры уплотнения сетки разбиения, если нужно, чтобы сетка 

разбиения была уплотнена в областях с высокой скоростью изменения 
поля;  

• диапазон частот анализа. 

При решении задачи методом HFSS-IE можно выполнить импорт 
расчета, выполненного методом конечных элементов в задачу, которая будет 
решаться методом интегральных уравнений. Для этого можно 
импортировать рассчитанные в HFSS поля в дальней зоне Far Field Wave или 
в ближней зоне Near Field Wave.    В проект можно включить больше, чем 
одну установку на решение. Причем можно задать методы решения HFSS 
или HFSS-IE, добавляя конструкции, решаемые разными методами.  

 

Рис. В.2. Пространственная диаграмма направленности антенной решетки, 
элементами которой в HFSS-13 могут быть щелевые, вибраторные, 
спиральные, пач-антенны, антенны Вивальди и др. излучающие элементы 
 
        В HFSS-13  реализован новый вид порта - порт Флоке. Он используется 
при моделировании периодических структур. Применение этого порта 
разберем в следующей главе, в которой будет моделироваться бесконечная 
граница раздела двух диэлектрических сред.  
   Благодарим за плодотворные дискуссии, просмотр и обсуждение рукописи 
к.т.н., в.н.с. Мишустина Б.А. и к.т.н. Подковырина С.И. 
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1. Моделирование наноструктуры в оптическом диапазоне 
частот 

  
      При проектировании оптических приборов часто возникает задача 
оптимизации характеристик отражающих поверхностей [7,8]. В качестве 
перспективной отражающей поверхности в научных исследованиях и 
прикладных разработках используют периодическую структуру, состоящую 
из металлических конусов (см. рис. 1.1).  Такая структура считается 
перспективной для создания оптических усилителей, преобразователей 
частоты и других приборов. 
 

    
                         a)                                                                   б) 

 
в) 

Рис. 1.1. Схема a) и топология б) оптического усилителя, в) фрагмент 
модели наноструктуры, используемой для создания оптических усилителей 

 
Представленная на рис. 1.1 реализация отражающей поверхности не 

является единственно возможной. Используются также структуры с 
полусферическими и эллиптическими окончаниями, дисками и т.д. Во всех 
случаях перед системой электродинамического моделирования стоит задача 
расчета частотной характеристики коэффициента отражения от 
периодической структуры. 

Формулировка граничной задачи выглядит следующим образом: на 
бесконечную в плоскости XOY периодическую структуру падает из верхнего 
полупространства плоская волна. Требуется найти рассеянное структурой 
поле.  
 Естественным методом анализа бесконечных периодических структур 
является применение условий периодичности, которые сводят задачу для 
бесконечной структуры к анализу одного периода.  
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 Следует отметить, что анализ падения плоской волны на бесконечную 
периодическую структуру является достаточно новой задачей в практике 
применения таких программных средств как HFSS. Поэтому, прежде чем 
перейти непосредственно к расчету структуры показанной на рис. 1.1, 
целесообразно численно с помощью аппарата периодических граничных 
условий решить тестовую задачу и сравнить численное решение с 
аналитическим. В качестве тестовой структуры была выбрана граница 
раздела двух сред. Для нее известно строгое аналитическое решение в виде 
коэффициентов отражения и прохождения плоских волн [6, 7], которые 
будем сравнивать с численными результатами. 
 
Падение плоской волны на границу раздела двух сред. При падении плоской 
волны на поверхность раздела двух сред, её поляризация не меняется. Если 
вектор Е лежит в плоскости падения, то такая поляризация называется 
параллельной, если вектор E перпендикулярен плоскости падения – 
перпендикулярная поляризация. 

Для моделирования бесконечных периодических структур  в программе 
HFSS используются периодические граничные условия, которые 
устанавливаются на противоположных сторонах бокса, охватывающих 
период анализируемой структуры. Пример использования граничных 
условий этого типа показан на рис. 1.2. Верхний параллелепипед заполнен 
вакуумом с диэлектрической проницаемостью равной единице, нижний – 
диэлектриком с относительной проницаемостью 2.25. Размер бокса по осям 
0X  и  0Y равен в данном примере 320 нм. 

Бесконечная граница раздела двух сред, строго говоря, не является 
периодической структурой. Поэтому применение аппарата периодических 
граничных условий для ее анализа нуждается в пояснении.  
 Рассмотрим известное [6] представление поля внутри прямоугольного 
канала Флоке. Под каналом Флоке понимается часть пространства, 
ограниченная вертикальными стенками (см. рис. 1.2), на которых 
установлены периодические граничные условия. Для прямоугольного канала 
Флоке составляющие поля E, H при 0>z   имеют следующий вид 

       ∑∑ −−−=
n m

zyixi
mn

mnmneazyхE ,
,),,( γβκ

,   (1) 

 
где      yxL , – периоды повторения структуры по осям 0X и 0Y (рис.1.2),  

       xn Ln /20 πκκ += ,       ym Lm /20 πββ += ,    

       
222

, mnmn k βκγ −−= ,  mna , – амплитуды n, m гармоник, k  - 
волновое число свободного пространства.  
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 Постоянные 00,βκ  задаются падающим полем, которое имеет вид 
плоской волны: 
    ϕθκ cossin0 k= , 
    ϕθβ sinsin0 k= , 
θ  - меридиональный угол падения плоской волны, а ϕ  - азимутальный угол.  
 Ряд (1) называется в теории периодических структур разложением поля 
по гармоникам Флоке, каждая из которых является членом ряда (1). Можно 
увидеть, что гармоника Флоке с нулевыми индексами 0== mn , которую 
часто называют основной гармоникой, имеет структуру поля, совпадающую 
с полем падающей волны. Так как мы рассматриваем полупространство при 

0>z , то она описывает поле отраженной волны.  
 Можно записать разложение аналогичное (1) для полупространства при 

0<z . Основная гармоника в этом разложении будет соответствовать 
прошедшей (преломленной) волне.  
 Гармоники высших порядков необходимы для описания ближнего 
поля, которое возбуждается, если период имеет сложную структуру, 
например, показанную на рис. 1.1 б, в. В случае плоской поверхности вид 
решения электродинамической задачи известен [2,6,7]. Поле описывается 
отраженной и преломленной волнами. Высшие гармоники Флоке не 
возбуждаются.  
 Таким образом, применение периодических граничных условий для 
анализа границы раздела двух сред оправданно тем, что отраженная и 
преломленная волны описываются основными гармониками Флоке, а 
гармоники высших порядков не возбуждаются.  
  

               
 
Рис. 1.2. Фрагмент диэлектрической подложки, на которую падает плоская 

волна.  
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    Интересно отметить, что поле основной гармоники не зависит от периодов 
yxL , . Поэтому при решении тестовой задачи размеры отдельных ячеек 

можно выбирать произвольным образом, так как зависящие от величины 
периодов гармоники Флоке высших порядков, как отмечалось выше, не 
возбуждаются. 
 
Решение задачи о падении плоской волны с помощью HFSS. Рассмотрим 
далее решение тестовой задачи о падении плоской волны на границу раздела 
двух сред с помощью HFSS. 

Черчение структуры. Установка периодических граничных условий. 
Установка портов Флоке. 

Командой  Modeler->Units выведем диалог, показанный на рис. 1.3, в 
котором зададим единицу измерения длины - нанометр (nm).  

 
Рис. 1.3. Установка единиц размеров структуры 

 
   Начертим бокс размером 320 nm x 320 нм и высотой 200 нм командой  
Draw->Box (рис. 1.4). Размеры бокса в плоскости XOY несущественны. Мы 
выбрали их равными периодам структуры, изображенной на рис. 1.1. 
Создаваемый бокс расположен в нижнем полупространстве и заполнен 
материалом с диэлектрической проницаемостью отличной от единицы. 
 

 
Рис. 1.4. Черчение бокса - фрагмента диэлектрической плоскости 

 
Определим его параметры, нажимая на кнопку Add Material (рис. 1.5). 
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Рис.  1.5. Добавление диэлектрика с проницаемостью 2.25 в проект 

 
Аналогично зададим сверху этого бокса, бокс размером 320 нм x  320 

нм и высотой 800 нм. Данный бокс не имеет диэлектрического заполнения. 
Нажмем далее клавишу F, чтобы перевести объект в режим выделения 

сторон и установим на вертикальных сторонах верхнего и нижнего боксов 
периодические граничные условия Master и Slave (рис.1.6). 

            
Рис. 1.6. Постановка периодических граничных условий на стороны боксов 

 
Таким образом, в структуре будут присутствовать 4 пары поверхностей 

типа Master-Slave. 
Для решения граничной задачи в системе HFSS на горизонтальных 

поверхностях, ограничивающих канал Флоке по вертикали необходимо 
установить порты, которые получили название портов Флоке. Для установки 
порта Флоке выделим нижнюю поверхность нижнего бокса и зададим 
команду Assign Exitation -> Floquet Port, по которой вызывается диалог 
рис. 1.7.  
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Рис. 1.7. Установка портов Флоке на нижнюю и верхнюю сторону 

 
        Параметры порта задаются в диалоге, показанном на рис. 1.8. Данный 
диалог позволяет работать с многомодовыми портами Флоке. Поэтому в нем 
имеется возможность задания номера гармоники, которая используется для 
определения параметров порта. Мы работаем с двухмодовыми портами 
Флоке. Такой режим соответствует каналу Флоке с двумя 
распространяющимися гармониками. Обе они имеют индексы n=0,  m=0, 
которые мы установим в данном диалоге. Отличие между двумя 
распространяющимися гармониками Флоке состоит в разной их 
поляризации. В нашем случае мы имеем волны с параллельной и 
перпендикулярной поляризациями. В терминологии, принятой в HFSS эти 
две волны обозначены как волны TM и TE. Поэтому в строке число волн 
(number of modes) ставим цифру 2 (две волны),   а в качестве мод выберем 
волны TM (H) и TE (E). 
 

 
Рис. 1.8. Установка параметров порта Флоке при решении задачи 

 
В HFSS порты Флоке можно ставить только на изотропную среду с 

диэлектрической проницаемостью равной единице. Поэтому установить 
порт непосредственно на нижней поверхности диэлектрика мы не можем. 
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Нам необходимо создать некоторый воздушный зазор между средой и 
портом. 

Если между нижним портом Флоке и диэлектрической средой остается 
зазор (рис. 1.12), то в расчет вносится погрешность из-за отражения волн от 
новой границы раздела. Необходимость создания такого зазора можно 
считать недостатком программы HFSS.  

Для того, чтобы такое вторичное отражение исключить, ставим снизу 
вместо порта поглощающую границу Radiate, соприкасающуюся с нижней 
стороной диэлектрической платы. При этом мы теряем возможность расчета 
коэффициента прохождения через структуру, так как порт в нижней части 
канала Флоке заменяется указанной границей. Тем не менее, возможность 
расчета коэффициента отражения сохраняется. 

Плоская падающая волна задается командой Assign Exitation -> 
Incident Wave ->Plane Wave. По этой команде появляется диалог рис. 1.9, 
на закладке General Data которой установим координаты точки, в которой 
падающая волна имеет нулевую фазу. 

 

 
Рис. 1.9. Закладка General диалога падающей волны 

 
Угол падения связан с углом направления Eo, что задается в виде 

координат векторов k(-sin(Teta),0, sin(Teta)),  Eo(-
cos(Teta),0,sin(Teta)), которые устанавливаются в диалоге Incident Wave 
Source (рис. 1.10). Teta – переменная, которая задает угол падения волны. 
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Рис. 1.10. Параметризация угла падения плоской волны: вектора 

распространения k  и вектора электрического поля E.  
 

Чтобы рассчитать характеристики отражения и преломления падающей 
волны под разными углами падения, будем изменять угол падения плоской 
волны Θ  в плоскости ZОX (φ=0) в диапазоне 0…90°.  

Это выполняется с помощью параметрического анализа. Командой 
Optimetric->Add->Parametric  выведем диалог (рис. 1.11) задания 
параметров параметрического анализа (перебора параметра Teta). 

 
Рис. 1.11. Задание параметрического анализа при изменении угла падения 

 
В результате такого анализа получаем характеристики поля, картины 

поля, углы отражения и преломления электромагнитных волн для различных 
углов падения. 

Известны аналитические зависимости для коэффициента отражения и 
прохождения (передачи) при падении волны на границу раздела двух сред, 
т.е. при условии, что толщина платы стремится к бесконечности. 
Коэффициент отражения по полю для волны с параллельной поляризацией 
(рис. 1.12) равен [7] 

                θεθε

θεθε
2

2

sincos
sincos

−+

−−
=R ,     (2) 
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где ε - диэлектрическая проницаемость среды, на которую падает волна, Θ - 
угол падения. 

Коэффициент передачи поля для волны с параллельной поляризацией 
равен 

                         θεθε
θε

2sincos
cos2
−+

=T      (3). 

 
В силу отмеченных особенностей HFSS, не позволяющих установить порт 
Флоке на поверхность с диэлектрической проницаемостью отличной от 
единицы нам приходится ограничить толщину диэлектрического слоя d  и 
установить порт Флоке на поверхности отделенной от нижней поверхности 
слоя небольшим зазором (ср. с [14,15]). В этом случае формулы (2) и (3) 
непосредственно для сравнения с расчетными данными использовать нельзя. 
Их необходимо модифицировать с учетом второй границы диэлектрического 
слоя. Такую модификацию нетрудно выполнить, используя соотношения (2) 
и (3). В результате получаем следующие выражения для коэффициентов 
отражения и прохождения плоской волны через слой ss TR , : 

      kdi
kdis e

eR
RTRR γ

γ
2

22

2

1
−

−−
−= ,     (4) 

 

        
kdi

kdis e
eR

TT γ
γ

−
−−

= 22

2

1
, 

 
 

                       θεγ 2sin−= , 
 
где λπ /2=k  - волновое число свободного пространства. В формулах (4) 
под TR,  понимаются коэффициенты отражения и прохождения границы 
раздела двух сред для волн обеих поляризаций. Например, для волны 
параллельной поляризации в качестве TR,  надо взять параметры TR ,  

(2), (3). 
Расчеты, выполненные на HFSS и характеристики, рассчитанные по 

формулам (4), сравниваются на рис. 1.12. Кривые на рис. 1.12 построены для 
разных значений толщины слоя d =100, 200 и 300 нм. Точками показаны 
данные полученные с помощью HFSS, а сплошными кривыми по формулам 
(4). Видно, что расчетные и теоретические результаты хорошо совпадают. 
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Рис. 1.12. Рассчитанный на HFSS коэффициент отражения в диапазоне 

углов падения для разных толщин подложки 
 

Поэтому мы можем сделать вывод, что для моделирования падения 
электромагнитных волн оптического диапазона на металлические 
поверхности со сложной структурой можно использовать метод конечных 
элементов, реализованный в HFSS.  

 
Рис. 1.13. Коэффициент отражения падающей плоской волны с 

вертикальной поляризацией 
 

Убедившись, что численные расчеты совпадают с теоретическими 
результатами, можно выполнить моделирование поверхности, состоящей из 
конических металлических наноструктур, используемых для усиления 
люминесценции в оптическом усилителе (рис. 1.13).    
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      Серебряные поверхности с расположенной на них системой 
наноразмерных острий, используется для усиления люминисценции 
адсорбированных сред с ионами редкоземельных элементов, обусловленного 
плазмонами. С помощью HFSS-13 можно получить параметры таких систем, 
широко используемых в настоящее время в волоконно-оптических 
усилителях для длины волны 1.54 микрона[4].    
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2. Волноводная антенная решетка 
 
 

Выполним моделирование волноводной антенной решетки [1,13]. Ее 
излучающая апертура состоит из открытых концов квадратных волноводов 
(рис. 2.1). Считаем, что ось 0z направлена вдоль осей волноводов. Плоскость 
z=0 совпадает с апертурой решетки. 

Последовательность работы будет следующая: 
• создание отдельного излучателя в виде отрезка квадратного 

волновода;  
• создание бокса, расположенного сверху излучателя; 
• задание граничных условий  PerfectE на стенках волновода; 
• задание порта Флоке на торцевой поверхности бокса; 
• задание волноводного порта; 
• установки анализа; 
• запуск на расчет; 
• вывод характеристик. 

 
Рис. 2.1. Геометрия антенной решетки 

 
Геометрия антенной решетки показана на рис. 2.1. Рассматриваем 

модель в виде бесконечной решетки. Волноводные порты находятся в 
области 0<z  и имеют вид квадратных волноводных портов (рис. 2.2) с 
основной волной линейной поляризации. Направление вектора 
электрического поля этой волны показано на рис. 2.1 в виде стрелок. 
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Рис. 2.2. Модель HFSS одного элемента антенной решетки с 
координатными векторами 

      
Анализ бесконечной решетки можно свести к  анализу одного периода 

благодаря теореме Флоке, упоминавшейся в главе 1. Отметим, что для 
бесконечной решетки понятие диаграммы направленности (ДН) не может 
быть корректно определено, так как оно вводится только для источников 
излучения с конечными размерами. Строго говоря, ДН бесконечной решетки 
описывается дельта – функцией и физического смысла не имеет. Тем не 
менее, существуют приближенные приемы, позволяющие использовать 
результаты анализа бесконечной структуры для оценки ДН конечной 
решетки. О них будем говорить ниже. Непосредственно анализ бесконечной 
решетки позволяет судить о решении задачи ее согласования со свободным 
пространством. 

На рис. 2.2 показана геометрия одной ячейки бесконечной антенной 
решетки. Модель состоит из двух областей. Нижняя часть представляет 
волновод, и сверху его расположен воздушный бокс. На вертикальных 
гранях бокса устанавливаются периодические граничные условия. На 
верхней поверхности бокса задается порт Флоке. 

 
Создание модели отдельного излучателя. Чтобы создать отдельную ячейку 
антенной решетки необходимо выполнить следующие действия: 
 
1. Откройте проект и дайте ему имя  AGW. 
2. Командой  Draw>Box создайте произвольный бокс, и затем 
отредактируйте его параметры в разделе Edit>Properties (рис.2.3) 
3. Выберите созданный бокс и отредактируйте его прозрачность (параметр 
визуализации создаваемого объекта) Transparency = 0.8. 
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Рис. 2.3.Параметры волновода Рис. 2.4.Параметры воздушного 
бокса 

 
4. Операцией  Draw>Box создайте второй бокс и отредактируйте его 
размеры и свойства Edit>Properties (рис. 2.4). 
 
   Задание границ Master и Slave.  
 
1. Нажмите на клавишу F, переводя HFSS в режим выбора поверхности, 

выделите боковую сторону верхнего бокса и задайте команду  
HFSS>Boundaries>Assign>Master.  Появляется диалог границы Master. 

 
2. Оставьте имя по умолчанию как Master1. 
  
3. Кликните в выплывающем меню U vector, и кликните New Vector. 

Появляется диалог Measure и появляется Create Line. 
 
4. Задайте вектор  U координатной системы в месте, показанном на 

поверхности на рис. 2.2. Кликните нижний правый угол (начальная 
точка), и протащите курсор к левому углу (конечная точка) и кликните. 

 
5. Кликните  OK, чтобы закрыть диалог. 
 
6. Выберите противоположную фаску и вызовите ведомое граничное условие 

HFSS>Boundaries>Assign Slave... Появляется диалог Slave с выбранной 
закладкой General (рис. 2.5). 

 
7. Выберите Master1 как ведущую  границу Master. 
 
8. Начертите вектор U Vector как показано на рис. 2.5. 
 
9. Выберите режим Reverse direction для вектора V. 
 
10. Оставьте неизменными другие установки и нажмите OK. 
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Рис. 2.5. Диалог задания разности фаз между границами Master и Slave 

 
 
11. Повторите эту процедуру для границ Master2 и Slave 2, как показано на 
рис. 2.6. Для вектора V на границе Master2  нужно установить обратное 
направление (Reverse direction). 

         
Рис. 2.6. Границы Master и  Slave устанавливаемые на противоположные 

грани воздушного бокса модели антенны 
 

В диалоге на рис. 2.5 имеются две опции установки задержки фазы 
между границами Master - Slave: по углам сканирования Scan Angle и по 
задержке фазы Input Phase Delay. 
 
Задание волноводного порта. Отрезок волновода содержит 4 стороны, на 
которых нужно задать граничные условия PerfectE. Это будет 
соответствовать тому, что стороны металлические. Удерживая клавишу Ctrl, 
выделим 4 стороны нижнего бокса и зададим их как  идеальные 
электрические стенки командой Assign Boundarys -> Perfect E. 
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Рис.  2.7. Задание границы идеальной проводимости на стенках волновода 
     
     Чтобы задать волноводный порт: 
 
1.  Выберите нижнюю грань нижнего бокса (рис. 2.8). 
 
2. Нажмите правой кнопкой мыши и из выплывающего меню выберите 
Assign>Excitations>WavePort. Появляется ассистент WavePort. 
 
3.  Установите в нем количество мод равное 2. 
 

        

Рис. 2.8. Задание интегральных линий квадратного волноводного порта 
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5. В разделе Integration Line выберите New  line и начертите две взаимно 
перпендикулярные интегральные линии для каждой моды, как показано на 
рис. 2.5. 
6. Оставьте другие установки, используя команду Next для перехода  к 
   другой странице и кликните OK.  Заданный волноводный порт появляется 
в списке   Excitation. 
 Отметим, что выбор двух мод в порту обусловлен тем, что квадратный 
волновод является двухмодовым волноводом, в котором существуют две 
распространяющиеся волны, отличающиеся поляризацией поля. Задание 
интегральных линий показывает, что мы в качестве волн в порту используем 
волны двух ортогональных линейных поляризаций. 
 
Установка портов Флоке. На верхней грани верхнего бокса 
устанавливается порт Флоке. В отличие от граничного условия излучения и 
PML этот порт позволяет рассчитать и вывести значение коэффициента 
передачи S21 из волноводного порта в порт Флоке. 
 
     Для установки порта Флоке надо выполнить следующие действия: 
 
1. Выделите верхнюю грань верхнего бокса. 
2. Нажмите правой кнопкой мыши и выберите Assign>Excitation>Floquet 
Port из выплывающего меню. Появляется ассистент порта Флоке (рис. 2.9). 
 

 
 

Рис. 2.9. Выбор направлений веркторов согласования портов Флоке 
 
3.  В разделе Lattice Coordinate System определяются направления A и B 
порта Флоке. 
 
4. Щелкните Next, принимая Phase Delay по умолчанию, и снова Next для 
перехода к странице установке мод порта Флоке Modes Setup (рис. 2.10). 

По умолчанию диалог параметров мод Флоке включает две моды порта 
Флоке. Моды Флоке определяются двумя индексами mn,  и поляризацией 
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Polarisation State.  Индексы mn,  можно понять из формулы (1) в главе 1. 
Основная мода Флоке имеет нулевые индексы. Эта мода (волна) 
распространяется при любых, сколь угодно малых, периодах решетки. Если 
период решетки достаточно велик, то появляются распространяющиеся 
волны с ненулевыми индексами. Каждой паре индексов mn,  соответствуют 
две волны, отличающиеся поляризацией. 

 

 
Рис. 2.10. Выбор характеристик каналов Флоке 

 
Последний столбец таблицы мод маркируется "Attenuation 

(Затухание)".    Это - затухание моды вдоль направления, нормального к 
плоскости решетки в дБ на единицу длины. Значения для зеркальных мод 
составляет 0 дБ, так как они распространяются в свободном пространстве и 
поэтому не ослабляются. Данный параметр не задается, а рассчитывается 
программой. 

Моды высших типов могут быть как распространяющимися, так и 
затухающими. Режим их распространения зависит от угла сканирования. 
Возможны ситуации, в которых при малых углах сканирования мода 
высшего порядка затухает, а при увеличении угла она становится 
распространяющейся. Если периоды решетки меньше половины длины 
волны в свободном пространстве, то при любых углах сканирования 
распространяются только две основные моды. В нашем случае периоды 
больше половины длины волны. Поэтому при больших углах сканирования в 
дополнение к основным модам должны появляться распространяющиеся 
моды с ненулевыми индексами. 
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Рис. 2.11. Задание углов сканирования, от диапазона  которых зависит 

количество задаваемых мод в портах Флоке 
 

Нажмите на кнопку Modes Calculator (рис.2.12). Данный диалог 
необходим для расчета параметров мод Флоке и правильного выбора числа 
мод, необходимых для корректного описания порта. В появившемся диалоге 
нужно поставить углы, по которым будет выполняться сканирование луча в 
антенной решетке. Выше отмечалось, что наша решетка при больших углах 
сканирования может функционировать в многомодовом режиме. Рассчитаем 
параметры десяти мод (рис. 2.12), установив 10 в разделе Number of Modes. 

       
Рис. 2.12. Установленные моды в портах Флоке 
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5. В закладке Post Processing задается положение отсчетной плоскости. 
 

Установка отсчетных плоскостей используется, когда пользователя 
интересует фаза параметра рассеяния. По умолчанию отсчетная плоскость 
находится в плоскости волнового порта. Операция de-embeding позволяет 
изменить положение отсчетной плоскости. Данное изменение влияет только 
на фазы параметров рассеяния и не влияет на их модули.  
6. В закладке 3D Refinement можно моды Флоке, которые участвуют в 
адаптивном измельчении 3-D сетки.     

Сетка разбиения, которая создается HFSS на последующих шагах 
адаптации, является фактически компромиссной для одновременного 
анализа всех мод  одновременно. 
7. Примите другие настройки по умолчанию, и нажмите OK, чтобы закрыть 
мастер портов Флоке.  Порт Флоке появляется в дереве проекта в разделе 
Excitation. 

 
Зададим углы сканирования как переменные проекта, для чего: 

 
1. В меню задайте команду  Project>Project Variables. Это вызовет окно 
Properties для этого проекта (рис. 2.13). 
2. Кликните кнопку Add. Это вызовет диалог Add Property. 
 

 
Рис. 2.13. Диалог переменных проекта 

       
3. Установите имя переменной  $phi_scan, и ее величину 0 deg. Эта 
переменная будет использоваться в качестве азимутального угла. 
4. Кликните OK. Теперь переменная $phi_scan  будет добавлена  в окно 
проекта Properties. 
5. Кликните кнопку Add чтобы показать снова диалог Add Property. 
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6. Установите  имя переменной, описывающей угол места name = $theta_scan 
и его величину  0 deg. 
7. Кликните OK. Диалог Add Property закрывается и добавляется 
переменная проекта $theta_scan. 
8. Кликните OK, чтобы закрыть окно проекта Properties. 
 

Нужно заметить, что при использовании углов сканирования в моделях 
элементарной ячейки, плоскость периодичности (здесь плоскость антенной 
решетки) должна быть параллельной плоскости XOY в глобальной системе 
координат. 
 
Установки на решение. Чтобы сделать установки на анализ выполните 
следующие операции: 
 
1. Нажмите правой кнопкой мыши на  Analysis в дереве проекта и выберите  
Add Solution Setup. Откроется диалог Solution Setup (рис.2.14). 
2. В закладке General, установите частоту решения Solution frequency = 
299.79 Mhz, Maximum Number of Passes = 5, и Maximum Delta S = 0.02. 
 

        
Рис. 2.14. Диалог установки на решение 

 
3. В закладке Options, отметьте режим Do Lamda Refinement и установите 
опцию Lambda = Use Default. 
4. Установите Maximum Refinement Per Pass = 30%,  
                         Minimum Number of Passes = 5, и  
                         Minimum Converged Passes = 2. 
5. Выберите базовые функции Order Basis function: First Order, и кликните  
OK. 
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Запуск расчета и просмотр результатов. Запустите расчет командой 
HFSS>Analyze. После завершения, нажмите на иконку Results  и выберите 
Solution Data. 

На рис. 2.15 показано окно с матрицей рассеяния, которое появляется 
после завершения расчета. Отметим следующее. 
 
• S-матрица имеет размерность 6×6 с учетом 2-х мод портов Флоке.  
 
• Моды Флоке в этой S-матрице перечисляются в порядке, заданном в 
панели установки порта Флоке. При обращении к этой панели, мы, таким 
образом, имеем в виду, что 
 
           FloquetPort1:1 относится к моде Флоке TE00 и 
           FloquetPort1:2 относится к моде Флоке  TM00. 
 

 
Рис. 2.15. Диалог данных решения Solution Data 

 
• Столбцы и строки в матрице на рис. 2.15 соответствуют стандартному 
определению матрицы рассеяния. Столбцы соответствуют волнам, 
падающим на разные порты, а строки - волнам отраженным от разных 
портов. Например, первый столбец матрицы соответствует возбуждению 
падающей волной волнового порта 1. Элементы этого столбца равны 
амплитудам волн отраженных от разных портов в режиме, когда 
возбуждается только один волновой порт 1.  Возбуждение волнового порта 
соответствует работе решетки на передачу.   

 
• Столбцы, соответствующие портам Флоке описывают параметры решетки 
в приемном режиме.  
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Параметрическое свипирование угла сканирования. Чтобы показать 
возможности порта Флоке, рассчитаем зависимость  коэффициента 
отражения решетки по волновому порту, как функцию угла сканирования. 
Когда сканирование происходит в E-плоскости решетки, при угле 27.5° 
наблюдается эффект ослепления. Чтобы показать это, нужно найти 
характеристики в E-плоскости при изменении угла сканирования от scan = 0 o 
до scan = 90o. 
 
              Чтобы выполнить такой параметрический анализ: 
 
1. Нажмите на Optimetrics в дереве проекта и выберите Add Parametric. 
Это выводит диалог Setup Sweep Analsysis с закладкой Sweep Definitions. 
2. Кликните кнопку Add. Это выводит диалог Add/Edit Sweep. 
3. Из выплывающего меню Variable, выберите  $theta_scan. 
4. Выберите Linear step. 
5. Установите Start=0 deg, Stop=90 deg, и Step = 3 deg (рис. 2.17). 
 

 
 

 

Рис.   2.17. Задание диапазона 
изменение угла Theta в 

параметрической оптимизации 

Рис. 2.18. Выбор опции сохранения 
поля и сетки разбиения при 
выполнении параметрической 

оптимизации 
 
 
6. Кликните кнопку  Add  и  OK, чтобы закрыть диалог Add/Edit Sweep. 
Диалог Setup Sweep Analysis включает переменную $theta_scan. 
7. Откройте закладку General и убедитесь, что в Sim Setup установлен 
режим  Setup1 with the Include. 
8.  Откройте закладку Options чтобы убедиться, что опции Save Fields and 
Mesh отмечены, и что опция Copy Geometrically Equivalent Meshes (рис. 
2.18) не отмечена. В этом случае  на каждом шаге параметрического анализа 
будут сохраняться характеристики дальнего поля. 
 
9. Кликните OK. В разделе Optimetrics появляется установка Parametric. 
 
    Текущая пара основных мод, достаточных для описания нормального 
падения волны, должна быть дополнена модами высших типов для описания 
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решетки при больших углах сканирования.  Подготовка мод для 
параметрического свипирования состоит из следующих шагов: 
 
1. Повторно войдите в панель установки порта Флоке и щелкните по вкладке 
типов волн. Для того, чтобы определить список мод, нужных для 
моделировании при всех углах сканирования, используем калькулятор мод. 
2. Вызовите калькулятор мод, щелкая по кнопке Modes Calculator. 

Расчет калькулятора является дополнительной информацией, для 
создания списка рекомендуемых мод  для порта Флоке. Его результаты 
нужны для выбора числа мод и не влияют на расчетную модель решетки.  
3. Выберите 10 мод для порта (с запасом). Вероятно, мы уменьшим это 
число, но для этого требуется дополнительное исследование. 
4. Установите частоту 299.97 MHz, на которой будет выполняться 
моделирование. Если установки задачи содержат  две или больше частот 
свипирования, обычно выбирается наивысшая частота для того, чтобы 
обнаружить появление распространяющихся мод высоких порядков.  
5. Чтобы установить набор типов волн, который будет достаточным для 
каждого направления сканирования в параметрической развертке, углы 
сканирования развертки вводятся в формате "start-stop-step". Вводимые углы 
- сферические полярные углы в глобальной системе координат. 

Для данного случая угол Phi = 90°, так что введите это значение как 
стартовое значение и конечное значение в полях Phi. Угол сканирования 
Theta в развертке меняется от 0 до 90° с шагом 0.5°, так что введите эти те 
же самые значения в полях калькулятора Theta. 
6. Нажмите OK, чтобы запустить на расчет калькулятор и просмотреть 
рекомендуемый список мод (как на рис. 2.12). 

 
Рис. 2.20. Характеристики сканирования отражения и прохождения 

характеристик типов волн 
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Отметим следующее: 

 
• Исходная пара основных мод TE00 и TM00 остается сверху таблицы мод 
Флоке (рис. 2.12). Затухание их равно нулю, что означает, что эти моды 
распространяются без ослабления, то есть являются распространяющимися. 
• Затем в таблице идет вторая пара мод TE01 и TM01. Они распространяются 
без затухания, по крайней мере, в одном направлении. 
• Затем следуют шесть мод с минимальным затуханием 60 дБ/м. Эти моды не 
распространяются ни в одном из выбранных направлений. 

Теперь нужно сделать окончательный выбор числа мод, учитываемых в 
порту Флоке. Этот выбор основан на следующих соображениях. Любые 
моды Флоке, распространяющиеся хотя бы в одном направлении должны 
быть учтены в таблице мод. Поэтому в нее нужно включить первые четыре 
моды, которые достигнут порта Флоке неослабленными. 

Оставшиеся типы волн, имеющие ненулевое затухание, являются 
кандидатами на исключение из таблицы.  С точки зрения эффективности 
моделирования и интерпретации результатов лучше их удалить.   

В связи с этим отметим:  
Поскольку длина элементарной ячейки составляет 1.25 м, любая из 

последних шести мод, при возбуждении в прямоугольной апертуре, 
достигнет порт Флоке с затуханием равным 1.25 * 60.00 = 75 дБ, то есть 
очень сильно ослабленной. Поэтому в большинстве случаев такими модами 
при описании порта Флоке можно пренебречь. 
7. Таким образом, введем число мод в поле Number of Modes = 4. В списке 
мод остаются только моды TE00, TM00, TE01, и TM01. 
8. Кликните OK, чтобы выбрать этот набор мод и затем запустите 
параметрический анализ (это займет определенного время расчета). 
 
         Просмотр результатов параметрического анализа.  
 

Как только моделирование закончено, элементы S-матрицы как 
функции угла сканирования можно видеть в закладке Matrix Data или на 
графике. Анализируя матрицу рассеяния для разных углов сканирования, 
можно видеть, что связи между типами волн TE00 и TE01 очень маленькие. 
     
   Чтобы вывести зависимости модулей коэффициентов отражения и 
передачи ТМ, как функций угла сканирования выполните следующие 
действия: 
 
1. Кликните правой кнопкой на Results в дереве проекта, и выберите  Create 
Modal Solution Data Report>Rectangular Plot.   Появляется диалог Report. 
2. В закладке Trace, в разделе X выберите $theta_scan. 
3. Для  Y выберите S Parameter как Category, S(Wave Port1:1) как 
характеристику (Quantity) и модуль Mag как Function.  
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4. Кликните OK чтобы создать новый график.  Новый отчет выводится на 
экран и добавляется под именем Result в дереве проекта с первой 
трассировкой, приведенной под графиком. Кнопка Add Trace становится 
активной  в диалоге Reports. 
5.  Выберите имя характеристики в дереве проекта. Это выводит окно 
    свойств для Trace. 
6. Отметьте опцию Specify Name чтобы открыть поле Name и измените имя 
    на Reflection. Этим будет изменяться имя на характеристике. 
7. Добавьте два дополнительных графика и измените их имена: 
    mag(S(WavePort1:1, FloquetPort1:2)) соответствует TM00 Transmission; 
    mag(S(WavePort1:1,FloquetPort1:4)) соответствует  TM01 Transmission. 
8. В дереве проекта выберите X Y Plot 1.  Это показывает свойства Properties 
    для графика. 
9. Отредактируйте поля Name  на Reflection и Transmission и нажмите Enter. 
      

Результаты параметрического анализа представлены на рис. 2.20. 
Заметим, что коэффициент отражения стремится к единице при угле 27.5°. 
Этот эффект получил название эффекта ослепления, поскольку в 
окрестности угла ослепления эффективность решетки резко падает, т.к. вся 
энергия, поступившая на волновой порт не излучается в пространство, 
отражается. 

Также отметим, что тип волна TM01 становится распространяющейся 
приблизительно при угле 30°. Об этом говорит резкий рост коэффициента 
передачи из волнового порта в волну ТМ01 порта Флоке при углах больших 
30°. 

В данном примере рассмотрены вопросы согласования: коэффициент 
отражения решетки. В следующем разделе будут рассматриваться и  
характеристики излучения антенной решетки.  
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3. Антенная решетка из антенн Вивальди 

 
 
 

Выполним расчет антенной решетки, составленной из элементарных 
излучателей, каждый из которых представляет собой широкополосную 
антенну Вивальди.  Решетка из антенн Вивальди создается, используя 
периодические граничные условия и порты Флоке. 

Антенна питается коаксиальной линией с волноводным портом. На 
верхней поверхности ячейки антенной решетки  устанавливается порт Флоке 
(см. рис. 3.1). На боковых сторонах ячейки вводятся периодические 
граничные условия. При этом противоположные и параллельные друг другу 
стороны объявляются границами  Master и Slave. Подложка имеет 
диэлектрическую проницаемость εr = 6 и толщину 1.27 mm. Полосковые 
проводники являются 2D объектами с граничными условиями PerE. Расчет 
выполняется на частоте 4.5 ГГц и в режиме интерполяции в диапазоне 2 … 5 
ГГц.      
    

 
Рис. 3.1.  Интерфейс HFSS c отдельной антенной Вивальди 

 
 

3.1. Черчение антенны Вивальди 
 

Установим единицы измерения длины – миллиметры и начертим 
диэлектрическую плату в виде параллелепипеда размером 34 x 60 x 1.27 мм 
(рис. 3.2) командой Create -> Box. 
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Рис. 3.2. Размеры  антенны Вивальди, являющейся элементом антенной 

решетки 
 

Внесем диэлектрик в раздел переменных и зададим проницаемость 
параллелепипеда равной 4.  Параметры параллелепипеда можно 
отредактировать в диалоге рис. 3.3. 
 

 
Рис.  3.3. Размер подложки с проницаемостью 6  и толщиной 1.27 мм  
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Антенна Вивальди работает в большой полосе частот, и наибольшая 

широкополосность достигается при экспоненциальном изменении щели от 
начала рупора к растру. 

Начертим  проводники антенны Вивальди, используя функциональные 
зависимости. Черчение линии, которая задается в виде функции, 
выполняется по команде Geometry -> Curve -> Analitic Curve. Появляется 
диалог рис. 3.4, в который введем функциональную зависимость координат 
точек на ребре полоскового проводника от переменной t. Координата Z 
зависит от переменной t линейно. Поэтому зависимость координаты Y от t 
можно рассматривать, как зависимость от координаты Z. 
 

 
Рис.3.4. Задание функций, по которым чертится кривая 

 
Используем для задания формы кромки проводника 

экспоненциальную функцию:  
 
                      X(t)=0, 
                      Y(t)=0.25*exp(0.123*t), 
                      Z(t)=t. 
 

Ширина зазора между проводниками в самом узком месте при t=0 
равна 0.5 мм. Переменная  t меняется от 0 до 33.3 (рис. 3.4). Функциональная 
зависимость задается в 24 точках. 

Теперь дополним экспоненциальные кривые прямыми линиями  и 
окружностью, которые играют роль симметрирующего устройства системы 
питания антенны Вивальди (рис. 3.7). 
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Рис. 3.5. Топология и размеры симметрирующего резонатора 

 
Далее начертим окружность, играющую роль резонатора 

симметрирующего устройства антенны Вивальди  (рис. 3.5). 
 

 
Рис.  3.6. Параметры круглого резонатора, который является частью 

симметрирующего устройства 
 

Теперь начертим прямоугольник, который сформирует щелевую 
линию связывающую резонатор и коаксиальную линию (рис. 3.7). 
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Рис. 3.7. Черчение прямоугольника для создания щелевой линии 

 
После подготовки к черчению сложной формы, которая включает 

окружность, экспоненциальную линию, и все поверхности будущей антенны 
Вивальди, зададим команду Draw-> Line и выполним захват одной точки 
экспоненциальной кривой. Когда дойдем до точки, в которой нужно сделать 
переход на окружность, переведем режим черчения в  Center Point Arc 
(рис.3.8) 
 

 
 
Рис. 3.8. Переход из режима черчения отрезков линий (Straight) в режим 

черчения окружности с помощью центра и радиуса. 
 

Теперь нужно объединить экспоненциальный отрезок с ломаной 
линией командой Unite. Далее из замкнутой формы создадим плоскость 
командой Modeler -> Surface -> Cover Line.   
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Рис. 3.9.  Полосковый проводник антенны Вивальди с симметрирующим 

устройством 
 
     Далее выделим экспоненциальный отрезок и развернем его на 180°, 
просто переменой знака координаты  Y(t) (рис. 3.10). 

 
Рис. 3.10. Черчение второго полоскового проводника 

 
Возбудить антенну Вивальди можно разными способами. Можно, 

например, поставить дискретный порт между вибраторами антенны. А 
можно включить в структуру реальный отрезок коаксиальной линии, на вход 
которой включается СВЧ генератор. Начертим внутреннюю жилу 
коаксиальной линии в виде цилиндра длиной 8 мм.  Черчение коаксиальной 
линии выполняется командой Draw->Cilinder, по которой появляется диалог 
(рис. 3.11). 
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Рис.  3.11. Параметры внутреннего  провода коаксиальной линии радиусом 

0.375 мм длинной 8 мм 
 

Далее начертим внешнюю оболочку коаксиальной линии, также 
командой Draw->Cilinder, и зададим параметры, показанные на рис. 3.12. 
 

 
 
Рис. 3.12. Черчение внешнего цилиндра outer, на его верхней поверхности 

автоматически устанавливается условие Perfect E 
 

Далее начертим бокс излучения, окружающий антенну Вивальди,  
командой Draw -> Box и установим его размеры, показанные на рис. 3.13. 
 

 
Рис.  3.13. Задание размеров бокса, окружающего антенну Вивальди 34 x 36 

x 60 мм 
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На сторонах этого бокса зададим граничное условие Radiate.  Зададим 

порт на торце коаксиальной линии (рис. 3.14). 
 
 

 

Рис. 3.14.  Создание волнового порта 
в сечении коаксиальной линии 

Рис. 3.15. Ячейка антенной решетки, 
охваченная периодическими граничными 

условиями 
 
 

Порт Флоке используется при моделировании бесконечных 
периодических структур (см. главы 1 и 2). Анализ бесконечной структуры 
сводится к анализу одного периода структуры (элементарной ячейки). На ее 
противоположных боковых сторонах задаются условия периодичности. На 
верхней поверхности необходимо выполнить одно из возможных 
«открытых» граничных условий, моделирующих процесс излучения в 
свободное пространство. В качестве поверхностей с «открытыми» 
граничными условия в HFSS используются PML, поверхность излучения и 
порт Флоке. 

Достоинством порта Флоке является то, что с его помощью можно 
описывать не только отражение волны, поступающей на вход антенны 
Вивальди, но и передачу энергии в свободное пространство. В бесконечной 
периодической структуре поле в свободном пространстве имеет вид 
гармоник Флоке. Каждая из таких гармоник является плоской волной, 
распространяющейся в пространстве под определенным углом. Как 
отмечалось в главе 1 и 2 большая часть гармоник Флоке является 
нераспространяющимися, а основная гармоники и одна-две гармоники 
высших типов могут распространяться. При этом гармоники высших 
порядков могут при одних углах сканирования быть распространяющимися, 
а при других нераспространяющимися. 

Использование порта Флоке позволяет рассчитывать коэффициенты 
передачи из волноводного порта в гармоники Флоке и наоборот. Как и в 
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случае волноводного порта, эта информация дается в форме S-матрицы, 
связывающей отраженные и падающие волны (рис. 3.19-3.24).  
 
 

                     
Рис.  3.16. Параметры порта Флоке, в таблице указано номер моды, 
состояние поляризации, индекс моды, затухание и режим уплотнения  

Affects Refinements 
 

Далее зададим центральную частоту 4.5 ГГц и выполним расчет 
антенной решетки в диапазоне частот от 2 до 5 ГГц. Результаты расчета 
частотной характеристики |S11| показаны на рис. 3.17. 
 

 
 
Рис.  3.17. Частотная характеристика коэффициента отражения от 

антенны Вивальди 
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Рис. 3.18. Ближнее поле в сечении антенны Вивальди и ток на поверхностях 

полосковых проводников 
 
 

Из рис. 3.18 видно, что антенна возбуждается симметрично, чего не 
было бы, если бы в структуре отсутствовало симметрирующее устройство.  
 

   
Рис. 3.19. Первая мода канала Флоке Рис. 3.20. Вторая мода канала Флоке 

 
 

Отметим, что с точки зрения электродинамики использование модели 
решетки в виде канала Флоке не позволяет рассчитывать ДН антенны этого 
типа, так как эта модель строго может использоваться исключительно для 
анализа бесконечной решетки, которая имеет ДН с нулевой шириной, то есть 
в виде дельта функции. Однако, в HFSS имеется возможность расчета ДН 
канала Флоке путем замены одного из портов Флоке на поверхность 
излучения. К этой возможности следует относится с осторожностью, имея 
ввиду, что получаемая ДН не является ни ДН решетки, ни отдельного ее 
элемента. Она дает лишь качественное представление о ДН решетки, когда 
она возбуждается по одному из ее входов. В антенной технике такую ДН 
называют ДН излучателя в составе решетки. Тем не менее, надо помнить, что 
расчет по описанной выше методике позволяет получить указанную 
характеристику лишь приближенно. 
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4.  Антенная решетка на вибраторных антеннах 

 
   

Рассмотрим антенную решетку из четырех вибраторных антенн с 
металлическим отражателем (рис. 4.1).   В такой решетке положением луча 
можно управлять, изменяя фазы напряжений, подводимым к отдельным ее 
элементам. Отражательная панель улучшает характеристики решетки, 
создавая в горизонтальной плоскости однонаправленное излучение.  

Выполнить анализ такой антенной решетки можно в единой 
конструкции, т.е. не применяя периодических граничных условий. 
 

 
Рис. 4.1. Антенная решетка с отражателем 

 
Элементы решетки расположены на тефлоновой подложке толщиной 

1.6 мм. Возбуждения осуществляются через дискретные порты.  Граница 
излучения задается на сторонах воздушного бокса.  Переменная фазового 
сдвига для постпроцессорной обработки имеет имя phase_shift. Центральная 
частота, на которой работает антенная решетка 1.9 GHz. 
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Рис. 4.2. Геометрия одной из четырех антенн, расположенных с шагом по 

оси Z равным 103 мм 
 

Начертим диэлектрическую подложку толщиной 1.6мм 
(диэлектрическая проницаемость 4), командой Draw->Box. Полученные 
размеры подложки можно откорректировать в диалоге рис. 4.3. 

      
 

Рис.  4.3. Диалог фрагмента диэлектрической платы 
 

Передвинем координатную систему на плоскость, на которой будем 
чертить вибратор, выделив сначала курсором одну из плоскостей 
(предварительно нажав F),  командой Modeler->Coordinate System ->Create 
->Face CS. 
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Далее начертим вибратор, по точкам, как многоугольник, задавая 
команду  Draw -> Polyline. 
 

 
Рис. 4.3. Черчение одной части вибратора 

 
Далее создадим новую систему координат, сдвинутую относительно 

начала системы по оси X на 18 мм, равную половине длины подложки 
командой Modeler-> Coordinat System -> Create -> Relative CS->Offset . И 
сделаем разворот с копированием этой части вибратора на 180° командой 
Edit->Duplicate->Around Axis. 
 

 
Рис.  4.4. Выбор оси Y, вокруг которой прокручивается вибратор с 

копированием 
 

Теперь между линиями вибратора начертим прямоугольник (рис. 4.5), 
на который затем устанавливается дискретный порт командой HFSS-
>Excitation->Assign->Lumped Port.  
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Рис. 4.5.  Постановка интегральной линии на дискретный порт 

 
 

Далее выполним копирование со сдвигом этой вибраторной антенны, 
чтобы получить 4 антенны, составляющих антенную решетку (рис.  4.7). 
 
Черчение отражателя. Конфигурация металлического отражателя 
уголкового типа показана на рис. 4.6. Взаимное расположение отражателя и 
диэлектрической платы с вибраторами представлено на рис. 4.7. Отражатель 
содержит отверстия, которые могут использоваться для вывода 
возбуждающих линий и соединения их с выходами делителя мощности, 
который играет роль схемы питания решетки. 
 

Рис. 4.6.  Положение отражательной плоскости антенной решетки с 
отражателем 

 
     Общая высота диэлектрической подложки 420 мм, а диэлектрическая 
проницаемость  ε=4. После черчения решетки, можно задать установки на 
расчет и диапазон частот анализа. При проведении расчета решетки нужно 
учесть, что антенная решетка представляет собой СВЧ многополюсник, 
имеющий четыре входа. HFSS рассчитывает матрицу рассеяния такого 
многополюсника в установленном диапазоне частот. Однако, получаемые 
при этом значения коэффициентов отражения не равны, представляющим 
наибольший практический интерес коэффициентам отражения решетки в 
рабочем режиме, в котором одновременно возбуждаются все четыре входа.  

 



  47

        
 

Рис. 4.7.   Структура и размеры антенной решетки. Общая высота 
рефлектора 420 мм 

   
Для определения коэффициентов отражения решетки в рабочем 

режиме Si,j_corr (i,j=1,…4) необходимо их рассчитать, используя элементы 
матрицы рассеяния S(i,j) по формулам, которые представлены на рис. 4.8.  
 

 
 
Рис. 4.8. Переменные, по которым считаются S-параметры антенны при 

одновременном возбуждении ее входов 
 

 На рис. 4.8 под Vi понимаются комплексные амплитуды напряжений, 
возбуждающих элементы решетки.  
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   Известно, что для уменьшения уровня боковых лепестков антенной 
решетки крайние элементы нужно возбуждать с меньшей амплитудой, чем в 
центре. Амплитуды возбуждения можно задать в качестве переменных (см. 
рис. 4.8). Если принять V_port1= V_port4 = 0.66 и V_port2= V_port3 = 1, то 
получим ДН, показанную на рис. 4.9. 

Разность фаз питания двух соседний антенн задается переменной 
phase_shift на этапе постпроцессорной обработки. Для создания такого 
режима, в диалоге, выводимом по команде HFSS>Fields>Edit Sources, в котором 
находится переменная offset phase. Задайте множитель переменной сдвига 
фазы phase_shift. 

    Задать переменную phase_shift  можно,  нажимая на имя проекта  
HFSSDesign2, в дереве проекта. Переменные проекта можно видеть в окне 
Properties.  В этом окне можно изменить величину phase_shift. Выберем 
phase_shift = 30º, что будет соответствовать графику на рис.  4.9.  

 

 
Рис. 4.9. ДН отдельного вибратора антенной решетки 
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Рис. 4.10. Трехмерная ДН антенной решетки 

 
При большом количестве элементов антенной решетки ее уже 

невозможно рассчитать в виде единой конструкции. Для решения такой 
задачи нужно использоваться периодические граничные условия. 
     Возбуждение каждого элемента антенной решетки выполняется с 
помощью многоканального делителя мощности (МДМ). Пример МДМ 
вместе с вибраторами показан на рис. 4.11. В случае синфазного возбуждения 
порты возбуждаются так, что поля в дальней зоне суммируются в 
направлении оси 0у. Этот процесс виден из распределения поля, показанного 
на рис. 4.11. 

 

 
Рис. 4.11. Ближнее поле в плоскости xOy  антенной решетки 
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   Отметим, что совместный расчет излучающей решетки вместе со 
схемой питания представляет собой для HFSS весьма сложную задачу, 
которая требует больших затрат компьютерных ресурсов. Такое положение 
обусловлено тем, что разветвленная микрополосковая схема, реализующая 
МДМ требует для своего анализа использования весьма густой сетки. 
Пример такой сетки представлен на рис. 4.12, на котором также показано 
распределение токов на металлических проводниках. 

 
Рис.  4.12. Вибраторная решетка, отражатель и схема распределения 

 
 Учитывая большую трудоемкость решения обсуждаемой задачи в 
HFSS, представляет интерес применение комплексного подхода, в котором 
сочетается использование разных программных средств для расчета разных 
фрагментов сложной структуры. При этом каждая часть анализируется с 
помощью методов в наибольшей степени адекватных физике ее 
функционирования. 
 

Расчет  МДМ  в  системе  MWO.  Схему  распределения  мощности  будем 
проектировать  в  системе  Microwave  Office  (MWO)  используя 
подпрограмму  EMSight,  которая  осуществляет  расчет  полосковых 
структур  методом  моментов.  Такой  подход  для  анализа  полосковых 
схем  намного  эффективнее  метода  конечных  элементов,  который 
используется  в  HFSS.  При  этом  излучающая  решетка  будет 
анализироваться  с  помощью  HFSS.  Ниже  мы  обсудим  возможность 
корректного  использования  данных  полученных  с  помощью  одной 
системы для расчетов в другой. В данном случае в MWO. 
 Проблема согласования расчетных данных, полученных в разных 
системах проектирования решается путем использования дискретных портов. 
Для этого при моделировании вибраторов применяется модель, показанная 
на рис. 4.13. Ее особенностью является использование двух дискретных 
портов P1,2, включенных между проводниками линии передачи, 
возбуждающей вибратор и металлическим отражателем. При таком 
представлении элемента решетки она рассчитывается в HFSS как СВЧ 
многополюсник с восемью выходами (шестнадцатиполюсник в 
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терминологии, принятой в России и восьмиполюсник по англоязычной 
терминологии – eight port junction).  

 
Рис. 4.13. Модель вибратора с двумя портами 

 
 Использование такой модели позволяет рассчитать матрицу рассеяния 
решетки без МДМ размером 8х8.  
 Рассмотрим далее основные этапы проектирования МДМ в системе 
MWO. МДМ представляет собой комбинацию нескольких элементарных 
делителей мощности ЭДМ на два канала, соединенных друг с другом 
линиями передачи. Структурная схема МДМ показана на рис. 4.14. 
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Рис. 4.14. Структура МДМ 

 
 В состав МДМ показанного на рис. 4.14 входят ЭДМ Д1, 
осуществляющий деление мощности пополам, ЭДМ Д2, делящий мощность в 
отношении 3:7 и возбудитель вибраторов В. Неравное деление мощности в 
ЭДМ Д2 обеспечивает спадающее распределение поля на краях решетки, 
благодаря которому снижается уровень боковых лепестков ее ДН в 
вертикальной плоскости. 
    Возбудитель В выполняет роль устройства питания вибраторной антенны. 
Выходами 1,2 он соединен с вибратором, который имеет два входа (см. рис. 
4.13).  
 Первый этап проектирования МДМ включает проектирование ЭДМ и 
возбудителя. Их топология показана на рис. 4.15 а-в. На рис. 4.15 а,б 
показаны топологии делителей Д1,2, а на рис. 4.15 в топология возбудителя. 
Они выполнены на подложке с проницаемостью 4.6 и толщиной 2 мм. 
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Рис. 4.15. Топологии ЭДМ и возбудителя 
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 Поскольку делитель Д1 имеет симметрию относительно портов 2 и 3, 
то его проектирование сводится к согласованию по входу 1. Все выходы 
устройства выполнены в виде микрополосковых линий с характеристическим 
сопротивлением 50 Ом. В качестве портов используются дискретные порты. 
Боковые плечи делителя содержат четвертьволновые трансформаторы, 
которые обеспечивают согласование выходных линий передачи со входной 
линией. На рис. 4.16 показана частотная характеристика коэффициента 
отражения делителя по входу 1. Видно, что наилучшее согласование 
достигается в окрестности частоты 1.7 ГГц. При удалении от нее 
коэффициент отражение растет, оставаясь однако достаточно малой 
величиной, не превышающей – 26 дБ в полосе 1.6 – 1.8 ГГц.  

 
Рис. 4.16. Частотная зависимость модуля коэффициента отражения 
делителя Д1 по входу 1 

 
 Делитель Д2 не имеет симметрии относительно входов 2 и 3, так как он 
обеспечивает несимметричное деление мощности. Поэтому его 
проектирование требует не только согласования по входу 1, но и реализации 
заданных значений коэффициентов передачи от входа 1 ко входам 2 и 3. Они 
должны быть равны следующим значениям: 5.121 −=S  дБ, 34.531 −=S  
дБ.  
 На рис. 4.17 показаны частотные зависимости модулей коэффициента 
отражения 11S  и коэффициентов передачи 21S  и 31S  делителя Д2. Видно, 
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что он достаточно хорошо согласован по входу 1 и обеспечивает заданные 
значения коэффициентов передачи. 
 

 

Рис. 4.17. Частотные характеристики делителя Д2 
 

 Возбудитель вибратора должен выполнить следующие функции. Он 
выполняет деление мощности, поступающей на вход 1 в равном отношении 
между входами 2 и 3. При этом фазы сигналов на портах 2 и 3 должны быть 
сдвинуты на 1800. В этом случае в двухпроводной линии, которая питает 
вибратор, будет возбуждаться ее основная волна, у которой токи на 
проводниках также сдвинуты по фазе на 1800. Важно также, чтобы выходы 
возбудителя были согласованы со входным сопротивлением вибратора. Его 
параметры подбирались в HFSS таким образом, чтобы входное 
сопротивление в точках размещения портов имело активную часть равную 60 
Ом и нулевую реактивную часть.  
 Исходя из этих условий, осуществлялась оптимизация топологии 
возбудителя. В результате были получены частотные характеристики, 
представленные на рис. 4.18 а,б. На рис. 4.18 а показана частотная 
зависимость коэффициента отражения по входу 1, а на рис. 4.18 б частотные 
зависимости фаз коэффициентов передачи 21S  и 31S . Видно, что 
возбудитель хорошо согласован и обеспечивает противофазное деление 
мощности.  
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 В системе MWO имеется возможность визуализации распределения 
токов на полосковых проводниках. Пример такого распределения на 
проводниках возбудителя показан на рис. 4.19.  

 
а 

 
б 

Рис. 4.18. Частотные характеристики возбудителя 
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Рис. 4.19. Распределение токов на полосковых проводниках возбудителя 

 
 Заключительная стадия проектирования МДМ состоит в расчете его 
выходных параметров. Топология МДМ показана на рис. 4.20. 

 
 

 
Рис. 4.20. Топология МДМ 

 
 В качестве примера на рис. 4.21 представлена частотная зависимость 
коэффициента отражения МДМ по центральному входу 1 (см. Рис. 4.14). 
Видно, что согласование МДМ несколько хуже согласования ЭДМ, однако в 
полосе частот коэффициент отражения не превышает – 20 дБ. 
 Следующий этап проектирования решетки состоит в расчете ее 
параметров с учетом результатов проектирования МДМ и излучающей части 
решетки в виде четырех вибраторов, выполненной в HFSS.  
 Эту часть работы удобно выполнить, экспортируя файлы данных из 
HFSS и MWO и обрабатывая их с помощью таких вычислительных систем 
как Маткад или Матлаб.  
 Файлы данных содержат матрицы рассеяния многополюсников, 
рассчитанные в HFSS и MWO. Матрица рассеяния решетки aS  представляет 
собой матрицу 8х8 в соответствии с числом ее входов. Аналогично матрица 
рассеяния МДМ dS  имеет размерность 9х9.  
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Рис. 4.20. Частотная зависимость коэффициента отражения МДМ по 

входу 1 
 

 Матрица dS имеет следующую структуру: 

   ⎥
⎦

⎤
⎢
⎣

⎡
=

ααα

α

SS
SS

Sd
1

111 ,      (5) 

где α  - группа входов с номерами 2 – 9. Таким образом, ααS  - это матрица 
размером 8х8, α1S  - матрица – строка размером 1х8, 1αS  - матрица – столбец 
размером 8х1 и 11S  - коэффициент отражения по входу 1.  
 Для расчета результирующего коэффициента отражения антенны R  
необходимо провести анализ каскадного соединения двух многополюсников, 
показанных на рис. 4.21. 

 
Рис. 4.21. Каскадное соединение МДМ и решетки 
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 Для определения коэффициента отражения R  воспользуемся 
соотношениями, приведенными в  [20]: 
  

1
1

111 )( αααααα SSSSESSR a
−−+= ,    (6) 

 
где E  - единичная матрица размером 8х8. 
  
    Также, из анализа каскадно-соединенных многополюсников, мы можем 
найти амплитуды падающих на входы решетки волн nU , 8...1=n . Их 
можно использовать далее для задания условий возбуждения решетки с 
учетом влияния МДМ. Зная эти амплитуды, мы можем с помощью HFSS 
рассчитать ДН антенны (рис. 4.10).  
 Использование разных программных средств, описанное выше 
позволяет рационально использовать их для решения тех задач, которые 
решаются с их помощью с наименьшими затратами компьютерных ресурсов. 
В данном случае HFSS используется для анализа трехмерной излучающей 
структуры, а MWO для анализа планарной полосковой схемы. В результате 
общее время, необходимое для получения конечного результата существенно 
сокращается. Кроме того, повышаются точность и достоверность решения.  
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5. Моделирование частотно-селективной поверхности 

 
 
 
К числу наиболее интересных задач прикладной электродинамики 

относятся задачи дифракции волн на периодических структурах. Широкое 
применение находят двумерно-периодические планарные решетки, которые 
получили название частотно-селективных поверхностей (ЧСП). Они 
используются в качестве пространственных фильтров, поляризационных 
фильтров, антенных обтекателей, средств радиозащиты и т.д.  

Отдельного упоминания заслуживает использование ЧСП в 
квазиоптических фидерах рефлекторных антенн метеорологических 
спутников. Применение ЧСП для построения частотно-селективных 
устройств позволяет существенно улучшить их массогабаритные 
характеристики.  

К устройствам этого типа предъявляются жесткие требования. Так, 
например, радиометр Европейского Космического Агентства MASTER 
должен обеспечивать разделение сигналов диапазонов 294-306, 316-326 и 
342-349 ГГц [13-17]. При этом вносимые потери не должны быть больше 
более 0.5 дБ, а развязка между каналами не меньше 20 дБ для уверенного 
детектирования слабых излучений молекул в атмосфере. Для минимизации 
вносимых потерь применяют апертурные ЧСП, позволяющие исключить 
диэлектрики и связанные с ним потери. Улучшение избирательных 
характеристик может быть достигнуто использованием многослойных 
структур, содержащих несколько параллельных слоев и многоэлементных 
периодических структур, содержащих несколько отражателей (апертур) в 
одной элементарной ячейке периодической структуры ЧСП. Проектирование 
такого рода устройств является актуальной задачей, решение которой сложно 
осуществить вне рамок строгого электродинамического моделирования. 
Создание модели ЧСП. Будем анализировать ЧСП с помощью периодических 
граничных условий, выделяя элементарную ячейку структуры в виде канала 
Флоке.  

Элементарная ячейка ЧСП может быть создана с использованием 
связанных границ с периодическими граничными условиями и двух портов 
Флоке. Результат решения граничной задачи анализа ЧСП представляется в 
виде S-матрицы, связывающей моды Флоке в соответствующих портах. 

В качестве примера, который рассмотрим в данной главе, служит 
проводящий экран, содержащий гексагональную решетку круговых апертур 
(отверстий). Геометрия решетки показана на рис. 5.1. На рис. 5.1 векторы 
решетки показаны углом. Угол между векторами решетки составляет 60°. 
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Рис.5.1. Геометрия частотно–селективной поверхности 
 
 

Рассмотрим нормально падающую плоскую волну на экран с 
поляризацией вектора электрического поля, показанной на рис. 5.1 красными 
стрелками. 

Рассчитаем  модули и фазы элементов матрицы рассеяния, как функции 
от частоты. Полоса частот от 8 до 20 ГГц. 

Модель одной ячейки показана на рис. 5.2. Длины стороны равна 1.73 
см, диаметр круглой апертуры равен 1.2 см и высота ячейки равна 4 см. 
Видно, что ячейка состоит из планарного металлического ромба с отверстием 
и бокса ромбической формы, на поверхностях которого заданы 
периодические граничные условия и порты Флоке. Приступим к созданию 
элементарной ячейки средствами HFSS. На первом этапе создадим 
ромбический бокс. 
       
Создание ромбического бокса. Для решения задачи выполните 
следующие действия: 
 
1. Откройте новый проект и назовите его RhombicArray. Установите 
единицы измерения длины – сантиметры (сm). 
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Рис. 5.2. Ромбовидная ячейка гексагональной ЧСП 

 
 
2. Кликните  Draw>Line, кликните в произвольном месте, чтобы установить 
начальную точку, затем кликните три другие произвольные точки и затем 
вернитесь к начальной точке, чтобы замкнуть фигуру. 
 
3. Кликните правой кнопкой, чтобы вызвать выплывающее меню и выберите 
команду Done. Этим создается многоугольник. 
 
4. В дереве проекта раскройте Sheets>Unassigned>CreatePolyline, выбрав 
первую операцию CreateLine  чтобы увидеть свойства этой линии. 
 

 
5.  Установите координаты первой точки Point1 = (0,0,0). 
 
6. Отредактируйте координаты Point2 = (0.865, 1.4982, 0). Это будет сдвиг 
сегмента первой ломаной линии, который даст требуемый размер объекта.  
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7. Повторите этот процесс со следующими тремя операциями  CreateLines в 
дереве создания и отредактируйте в них значения Point2, Point3 и Point4 (рис. 
5.3) следующим образом: 
                  Point2 (0.865, 1.4982, 0) 
                  Point3 (2.595, 1.4982, 0) 
                  Point4 (1.73, 0, 0) 
                 

Созданный плоский ромб можно использовать для создания 
ромбообразного  бокса.  Перед этим сделайте, командой Copy, копию ромба, 
которая будет полезна для создания металлического ромба. 
 

 
Рис. 5.3. Ромб как сечение будущей ячейки частотно-селективной 

поверхности 
 
8. Чтобы преобразовать плоский 2D объект в 3D ячейку, нажмите  
Draw>Sweep>Along Vector. 
 
9. В строке состояния, введите нули в ячейки X, Y, Z, чтобы задать 
начальную точку. 

Это помещает курсор в первую точку, задающую вектор, и изменяет 
сообщение строки состояния на “Input the second point of the sweep vector 
(ввести вторую точку вектора развертки)”. Метки ячейки показывают 
величины сдвигов dX, dY, и dZ. 
 
10. В статус-баре введите 0, 0, и 4 и нажмите Enter.  Это начертит линию от 
начальной до конечной точки, и выведет диалог Sweep Along Vector (рис. 
5.4). 

 
 
11. В диалоге Sweep Along Vector, оставьте 0 deg как черновой угол, и 
выберите Round из выпадающего меню как тип Draft type. Затем нажмите 
OK. 
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Рис. 5.4. Завершение операции свипирования по вектору 
 

12. Эта операция преобразует ромб в 3D объект.  
13. Теперь сдвинем  этот объект вниз на 2 см, используя операцию Edit-
>Arrange-> Move. 
14. Откроется диалог Measure data и появляется возможность ввести  через 
статус-бар, а также курсором, опорную точку X, Y, и Z,   как первую точку 
вектора сдвига. 
15. В статус-баре установите Z = 0, и нажмите Enter. 
16. В статус-баре установите dZ = -2.0 и нажмите  Enter. 

Это сдвинет объект на нужное расстояние. 
 
     Создание плоского ромба с отверстием.  Если Вы сделали копию 
плоского ромба, то далее ее можно использовать. В противном случае 
повторите шаги 1 - 7. 
 
1. Кликните копию плоского ромба. 
2.  Командой Draw>Circle начертите круг, установив курсор в центре 
многоугольника.  
3. Откройте диалог свойств окружности и установите ее радиус 0.6 cm. 
4. Выберите одновременно окружность и прямоугольник и кликните 
Modeler> Boolean>Subtract. Откроется диалог Subtract. 

 
Рис. 5.5. Ячейка частотно-селективной поверхности 
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5. Переведите Rectangle в список  Blank, а окружность в список Tool. 
 
6. Кликните  OK, чтобы закрыть диалог и создать апертуру вычитанием 
окружности из прямоугольника. 
 
    Задание границ Master и Slave.  
    Для того, чтобы смоделировать ЧСП, которая состоит из периодически 
расположенных элементов, необходимо задать периодические граничные 
условия на противоположных стенках. 

Зададим границы Master и Slave на ромбическом объекте следующим 
образом. 
 
1. Выберите поверхность, показанную на рис. 5.6 и задайте команду  
HFSS>Boundaries>Assign>Master.  Появляется диалог Master Boundary. 
 
2. Оставьте имя по умолчанию как Master1. 
 
3. Чтобы установить вектор U вдоль по ребру  кликните New Vector.    
Появляется диалог Measure dialog и Create Line. 
 
4. Начертите вектор U vector на выбранной поверхности. Кликните на 
нижний левый угол как начальную точку, и прочертите курсор к правому 
углу и кликните Master1. 
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Рис. 5.6.Задание границ Master(ведущая)  и  Slave(ведомая) 

 
 
5. В диалоге  Master Boundary, для вектора V Vector, выберите опцию    
Reverse direction и нажмите OK. 
6. Выберите противоположную сторону и задайте команду     
HFSS>Boundaries>Assign Slave. Появляется диалог Slave с выбранной     
закладкой General. 
7. Для этой ведомой поверхности выберите  Master1 как ведущую границу. 
8. Начертите вектор U Vector как показано на рис. 5.6 и нажмите OK. 
9. Повторите процедуру для границ Master2 и Slave 2. 

 
Рис. 5.7. Создание второй пары периодических границ 
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Далее зададим граничное условие Perfect E для ромба с отверстием. 
Для этого нужно выбрать поверхность Aperture из дерева хронологии и 
задать команду HFSS>Boundaries>Assign>Perfect E. Граница PerfE1 
появляется в списке Boundary. 
 
     Задание портов Флоке.  
     Порты Флоке нужно установить на нижнюю и верхнюю поверхности 
модели. 
 
1. Выберите верхнюю поверхность модели и кликните 
HFSS>Excitations>Assign>Floquet Port.  Появляется ассистент порта Флоке, 
показывающий страницу General. 
 
2. Для координатной системы Lattice Coordinate System, из выплывающего 
меню для направления A, выберите  New Vector. 
 
3. Начертите вектор, нажимая нижний угол по оси Z начальную точку, и 
затем нажимая соседний угол вдоль по оси X. Когда вы сделаете двойной 
клик для завершения построения вектора, диалоги  Measure Data и  Create 
line исчезают, и снова появляется ассистент  Floquet Port, показывая, что 
вектор a определен. Повторите эту процедуру для вектора b. 
 
4. В закладке  Modes setup, введите  Number of Modes= 14. Таким образом, 
заполнится таблица Mode, которая будет иметь четырнадцать строк (рис. 
5.9). 

 
Рис. 5.8. Порт Флоке в пространстве ячейки частотно-селективной 

поверхности 
5. Кликните кнопку Modes Calculator для получения информации по 
установке мод. Появляется калькулятор мод. Установите частоту Frequency = 
20 ГГц (рис. 5.9). 
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Рис.  5.9. Калькулятор мод и установки на его запуск 

 
6. Оставьте остальные величины по умолчанию и кликните OK, чтобы 
закрыть калькулятор.  Это заполнит таблицу с рассчитанными данными. 
 
7. Выберите опцию Deembed, и задайте Distance = 2.0 cm. 
 
8. Кликните Next для перехода на страницу 3D Refinement. 
 
9. Для  1-й моды Mode 1, выберите опцию уплотнения Affects Refinement 
(рис. 5.10) и кликните Next для перехода на страницу Post Processing. 
 

 
Рис. 5.10. Результаты работы калькулятора мод 
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10. Кликните OK. Первый порт Флоке появится в разделе Excitations в дереве 
проекта. 
 
11. Выберите нижнюю поверхность модели, и повторите процесс, чтобы 
установить второй порт Флоке. Информация первого порта Флоке 
копируется. 
 

 
Рис. 5.11. Ближнее поле в сечении ячейки частотно-селективной 

поверхности 
 
Установка на анализ. Для этого выполните следующие операции: 
 
1. Нажмите правой кнопкой на Analysis в дереве проекта и выберите Add 
Solution Setup. Открывается диалог Solution Setup. 
 
2. В закладке General установите Solution frequency = 20 GHz. Установите 
Maximum Number of Passes = 10, и Maximum Delta S = 0.02. 
 
3. В закладке Options, отметьте режим Do Lamda Refinement, и установите 
Lambda target = 0.2. 
 
4. Установите Maximum Refinement Per Pass = 20%, the Minimum Number of 
Passes = 6, и  Minimum Converged Passes = 2. 
 
5.  Выберите функцию First Order Basis, и кликните OK. 
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Рис.  5.12. Выбор типов волн, по которым контролируется сходимость 

процесса 
 
    Расчет характеристик в диапазоне частот. Чтобы выполнить 
расчет в полосе частот: 
 
1. Кликните правой кнопкой мыши на Setup1 в дереве проекта и выберите  
Add Frequency Sweep. Появляется диалог Edit Sweep. 
2. Для Sweep Type, выберите опцию сглаживания данных расчета в 
диапазоне частот Interpolating. 
4. Установите Max Solutions = 50, и Error Tolerance = 0.5%. 
5. Кликните кнопку Advanced Options чтобы показать диалог Interpolating 
Sweep Advanced Options. 
6. Установите Minimum Solutions = 5, и  Minimum number of Subranges = 1. 
7. Для установки сходимости Interpolation Convergence, выберите кнопку  Use 
Selected Entries Radio, и кликните  кнопку Select Entries. Появляется   диалог 
Interpolation Basis Convergence (рис. 5.12). 
8. В диалоговом окне Interpolation Basis Convergence, оставьте Entry Selection 
и Mode Selections как All. Это значит, что все моды Флоке будут 
перечислены в таблице. Затем используйте вертикальную полосу прокрутки, 
найдите строку FloquetPort2:1 и установите значение ON в столбце 
FloquetPort1:1. 
 9.  В строке FloquetPort1:1 и в строке Floquet Port2:1 также установите опцию 
ON. 
10. Нажмите OK, чтобы закрыть этот диалог, OK чтобы закрыть Interpolating 
Sweep Advanced Options, и OK, чтобы закрыть диалог Edit Sweep. 

На рис. 5.13 – 5.14 показаны рассчитанные распределения полей 
разных мод канала Флоке. 
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Рис. 5.13. Поле 2-й моды Флоке Рис.  5.14. Поле 4-й моды Флоке 
 

 
11. Нажмите Analyze для запуска расчета.  
 
Просмотр результаты расчетов. Несколько частотных зависимостей 
модулей и фаз коэффициентов отражения и прохождения по основным типам 
волн показаны на рис. 5.15, 5.16. 
 

 
 

Рис.  5.15. Фазо-частотная характеристика коэффициента передачи из 
порта Флоке 1 в порт 2 по основной волне 

 
Из рис. 5.15 видно, что ЧСП обладает частотной селективностью для 

основной моды. Из 5.16 видно, что на частоте 18 ГГц ЧСП полностью 
прозрачна для падающей волны, так как на этой частоте ее коэффициент 
отражения стремится к нулю.  

Интересно также рассчитать свойства ЧСП для волн, падающих под 
разными углами на частотно-селективную поверхность. В этом случае нужно 
задать плоскую волну, угол падения которой будет параметрически меняться. 
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Рис.  5.16. Частотные характеристики модулей коэффициентов отражения 
и передачи ЧСП по основной волне 

 
 

  Отметим, что также можно рассчитать свойства ЧСП для волн, падающих 
под разными углами на частотно-селективную поверхность. В этом случае 
нужно задать плоскую волну, угол падения которой будет параметрически 
меняться. К частотно-селективным поверхностям можно отнести 
резонансную структуру, рассмотренную в гл.1. 
   Материалы можно задать так, что они будут иметь частотную зависимость 
своих параметров. Пример частотной зависимости материалов показывается 
на рис. 5.17. 
 

  
Рис. 5.17. Частотные зависимости материала (из примера ViaWizard) 
    Библиотека материалов HFSS можно пополнять моделями с линейно-
ломанными частотными зависимостями, моделями  моделями Дебая, 
моделями Дворжека-Сахарова,  а также пользовательскими моделями, все 
параметры которых можно ввести в табличном виде [1]. 
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6. Падение плоской волны на объект 

и расчет радиолокационного сечения рассеяния 
 

 
Радиолокационное сечение рассеяния характеризует способность 

объекта рассеивать падающие на него электромагнитные волны. В 
англоязычной литературе ему эквивалентен термин Radar Cross Section 
(RCS). Этот параметр используется для оценки возможности обнаружения 
объекта (цели) с помощью радиолокатора [4,5]. Кроме этого параметра, для 
оценки параметров цели используется эффективная площадь рассеяния 
(ЭПР). 

Рассмотрим определения параметра RCS. Выделяют два разных случая. 
В первом передающая антенна, облучающая исследуемый объект и приемная 
антенна, принимающая отраженные от него волны находятся в одном месте. 
В этом случае говорят о моностатической локации и параметры цели 
описывают с помощью моностатического RCS.  

Во втором случае приемная и передающая антенны находятся в разных 
точках (см. рис. 6.1). В этом случае говорят о бистатической радиолокации и 
используют, соответственно, бистатическое RCS. 

 
 

Рис. 6.1. Схема бистатической радиолокации 
 
 Параметры RCS и ЭПР связаны следующим образом: 
  

RCS= σ/λ2,      (7) 
 
где λ – длина волны в свободном пространстве, σ – ЭПР [м2].  RCS, 
определенный соотношением (6.1) называют также нормированным 



 74

радиолокационным коэффициентом отражения, поскольку он является 
безразмерной величиной. 
 ЭПР определяется через напряженность электрического поля 
падающей на объект волны Eпад в месте расположения объекта и 
напряженность поля волны рассеянной объектом в направлении 
расположения приемной антенны Eотр в месте расположения приемной 
антенны: 
                                σ= 4πr2  |Eотр|2 / |Eпад|2,    (8) 
где r – расстояние от объекта до приемной антенны.  
 Отметим, что соотношение (6.2) может использоваться как в случае 
бистатической, так  и моностатической радиолокации при соответствующем 
изменении напряженности поля рассеянной волны.  
 Из соотношения (6.2) видно, что ЭПР характеризует исключительно 
энергетические свойства объекта, так как в его определение входят 
абсолютные значения поля. Если представляет интерес фаза рассеянной 
волны, то в этом случае используют комплексный РСР, определяемый через 
комплексную ЭПР: 

падотр EEr /4 ⋅= πσ    (9). 
       HFSS-13 рассчитывает  бистатический, нормированный бистатический, 
комплексный бистатический и моностатический РСР. В этом примере мы 
рассчитаем нормированные РСР для бистатического и моностатического 
положений радиолокатора и цели.    Меняя угол IWavePhi от 0 до 180 
градусов (рис. 6.2), мы как бы совершаем «облет» цели, облучая цель со всех 
сторон (рис. 6.3) и принимая отраженный сигнал. 

 
Рис. 6.2. Параметры плоской волны с установками для расчета 

моноимпульсного RSC 
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Общая процедура расчета RCS объекта методом конечных элементов, в 
частотной области, состоит из следующих шагов: 
 
1. Создание проекта  HFSS. 
 
2. Черчение геометрической модели, включающее: 

• установку область черчения (бокс, в котором будет размещен 
объект); 

• создание объекта; 
• задание материала объекта (в нашем случае объект, на который 

падает плоская волна, идеально проводящий). 
 
3. Установка параметров решения задачи: 

• установка граничных условий на поверхностях бокса (мы будем 
использовать условия PML); 

• установка источника возбуждения (плоская волна); 
• установка критериев сходимости и параметров разбиения. 

 
4. Расчет RCS. 
 
5 . Постпроцессорная обработка для визуализации RCS. 
 

Применим этот алгоритм для расчета рассеяния от простейшего 
объекта - идеально проводящего куба в пространстве. 

 

Создание модели (RCS Model). Выбираем тип задачи Driven Modal.     
 
Чтобы установить единицы длины: 

 
1. Кликните  Modeler>Units. Появляется диалог Set Model Units. 
2. Выберите единицы meter из меню Select units. Опция Rescale to new units 
не включается. 

Если установлена опция Rescale to new units, то геометрическая сетка 
автоматически масштабирует расстояние между линиями сетки к единицам, 
введенным так, что разница будет соответствовать установленным единицам.    
3. Кликните OK, чтобы установить метры, как единицы длины для этой 
модели. 
 

Построим идеально проводящий (PEC)  куб, окруженный воздушным 
боксом (рис.6.3).  На поверхностях бокса установлены граничные условия 
PML.  

На этот куб падает плоская волна. Выполним расчет RCS- Radar Cross 
Section. 
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Рис. 6. 3. Проводящий куб внутри воздушного бокса 

 
      Для создания куба, используем команду Draw>Box. Идеально 
проводящий куб имеет ребро длиной 0.75  метра (рис.6.4).  
 

 
Рис. 6.4. Параметры проводящего куба 

 
     Чтобы установить свойства куба: 
 
1. Выберите созданный бокс и кликните Properties из выплывающего меню. 
Это выводит диалог Properties. 
2. Дайте имя объекту. 
3. В поле материала задайте материал  pec из списка и нажмите OK. 
4. В диалоге Properties отредактируйте цвет и выберите его красным. 
5. Установите прозрачность 0.6. 
6. Кликните OK, чтобы выбрать эти установки и закрыть диалог. 
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Создание воздушного бокса. Начертим бокс размером 1.4 м с центром в 
начале координат, с прозрачностью 0.9. Назовем его air_box. Начертим 
воздушный бокс по команде Draw>Box, и отредактируем его размеры в 
диалоге, показанном на рис. 6.5. 
 

 
Рис. 6.5. Размеры воздушного бокса 

 
     Стороны воздушного бокса будут удалены от исследуемого идеально 
проводящего  куба на расстояние большее, чем длина волны, учитывая 
частоту 300 МГц, которую мы будем использовать. 
Задание границ PML. Чтобы создать границы PML: 
 

1. Установите опцию выбора поверхности и введите команду 
Edit>Select>Face, или нажимая клавишу F. 

2. Выберите  Edit>Select>By Name, или выберите значок в меню. Это 
выведет диалог Select by Face. 

 
3. В списке имен объектов, выберите air_box.  Этот список называется 

air_box faces. 
4. Удерживая клавишу Ctrl, кликните каждую поверхность бокса. Все 

поверхности air_box должны быть подсвечены (рис. 6.6). 
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Рис. 6.6. Выбор всех сторон воздушного бокса 
 
5. В окне черчения, вызовите правой кнопкой мыши всплывающее меню и 
выберите  Assign Boundary> PML Setup Wizard.   Появляется ассистент 
установки (рис. 6.7). 
 

 
Рис. 6.7. Ассистент установки поверхности PML 

 
6. В поле Uniform Layer Thickness (рис. 6.7), установите толщину слоя 0.4 м. 
Параметры слоев PML будут откорректированы автоматически в 
соответствии с новой толщиной. 
 
7.  Установите опцию  согласования углов и ребер: Create joining corner and 
edge objects и кликните Next.  Это создаст объекты PML и появится диалог 
Material Parameters (рис. 6.8). 
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Рис. 6.8. Установки для расчета параметров PML 

 
8. Установите минимальную частоту Min Frequency = 0.3 GHz,  и 
минимальную дистанцию излучения Minimum Radiating Distance = 0.3 м. 
 
9 . Кликните  Next чтобы вывести итоговый диалог PML Summary (рис. 6.9). 
 

 
Рис. 6.9. Завершающие установки в работе  ассистента PML 

 
10. Кликните Finish чтобы закрыть диалог рис. 6.9. Границы PML появляют-
ся в разделе Boundaries в дереве проекта, и объекты PML перечисляются в 
дереве проекта. 
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Разбиение на тетраэдры воздушного бокса. Параметры разбиения бокса 
air_box будут сильно влиять на точность расчета диаграммы направленности. 
Для установки этих параметров: 
 
1. Выделите поверхности бокса air_box. 
2. Кликните правой кнопкой мыши на  Mesh Operations в дереве проекта. 
3. Кликните Assign>On Selection>Length Based.    Это выведет диалог 
Element Length Based Refinement (рис. 6.10). 
 

 
Рис. 6.10.  Диалог задания параметров разбиения 

 
4. Установите в нём параметр Maximum length of Elements = 0.2 м. 
5. Кликните  OK чтобы закрыть этот диалог. В дереве проекта в папке Mesh 
Operations появится значек Length1. 
 
 

     Установка параметров падающей волны.  
 

1. Задайте команду из меню HFSS>Excitations>Assign>Incident 
Wave>Plane Wave. Появляется страница Incident Wave Source: 
General Data (рис. 6.11). 

2. Напечатайте имя источника в боксе Name. 
3. Выберите в разделе  Vector Input Format как Spherical. 
4. Введите 0, 0, 0 для X-, Y-, и Z-координат of the Excitation Location 

and/or Zero Phase Position (исходная точка для падающей волны). 
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Рис. 6.11.  Задание фазового центра падающей планарной волны 

 
5. Кликните Next. 
6. Появляется диалог Incident Wave Source: Spherical Vector Setup (рис. 
6.12). 
 
a.  В разделе  IWaveTheta, введите   Start=0 deg, Stop = 90 deg, и Step=3deg.  
Для моностатического случая, RCS будет рассчитываться только для углов 
IWaveTheta,  введенных здесь. Таким образом, радиолокационный 
коэффициент отражения будет рассчитываться для тридцати  углов. 
 
b. Кликните  View Point List (рис. 6.12) чтобы видеть заданные значения угла 
θ. 
 

 
Рис. 6.12.  Параметры падающей плоской волны 

 
7. Кликните Next. Появляется страница Incident Wave Source: Plane Wave 
Options (рис. 6.13). 
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8. В разделе Type of Plane Wave выберите Regular/Propagating;  все другие 
поля станут неактивные. 

 
Рис.6.13.  Параметры падающей волны 

 
10. Кликните Finish. Падающая волна, которую Вы определили, добавляется 
в список Excitations и линии ее падения можно видеть на рис. 6.14. 
 

 
Рис. 6.14.  Исследуемый куб и углы, для которых будет рассчитываться RCS 
 

Далее опишем, как выполнить установки параметров бесконечных сфер 
для моностатического и бистатического эксперимента. Для этих 
конфигураций можно рассчитать графики нормированного бистатического и 
моностатического RCS.  
 
Создание бесконечной сферы для определения дальнего поля. Чтобы 
рассчитать излучаемые поля в дальней зоне, нужно установить сферу, 
которая окружает объект излучения. 
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Для этого примера, создадим установки для бистатического и 
моностатического случаев. 

Когда вы устанавливаете сферическую поверхность,  чтобы 
анализировать ближние поля или поля в дальней зоне, Вы задаете диапазон 
изменения и шаг изменения углов φ и θ (азимутальный угол и угол места). 
Они указывают направления, в котором Вы хотите оценить излучаемые поля 
(см. рис. 6.15). Для каждого значения угла φ имеется соответствующий 
диапазон значений для θ, и наоборот. Это создает сферическую сетку. Число 
точек сетки определяется размером шага для φ и θ. 
 

 
Рис. 6.15. Сферическая система координат 

 
Установка параметров в моностатическом случае Monostatic Setup.  
 

1. Кликните HFSS>Radiation>Insert Far Field Setup>Infinite Sphere. 
Появляется диалог Far Field Radiation Sphere Setup (рис. 6.16). 
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Рис. 6.16. Задание сферы, на которой задаются точки, в которых 

рассчитываются характеристики дальнего поля 
 
2. В закладке Infinite Sphere, напечатайте имя для сферы в окне Name. Для 
моностатической сферы напечатайте имя monostatic. 
3. Определите диапазон изменения углов в диалоге рис. 6.16. Для 
моностатического случая углы не меняются, так как положение приемной 
антенны фиксировано и совпадает с положением передающей антенны. 
Поэтому RCS рассчитывается только в направлении, определяемом 
падающей волной. Это направление определяется углами IWavetheta и 
IWavephi, которые уже были заданы при определении источника 
возбуждения (рис 6.12). 
4. Откройте закладку Coordinate System (рис. 6.16), и сориентируйте сферу 
в глобальной системе координат (CS). Выберите Use global coordinate 
system. Если вы хотите сориентировать сферу в соответствии с системой 
координат, выбранной пользователем, можно выбрать Use local coordinate 
system и выбрать систему координат из списка Choose from existing 
coordinate systems. 

 
5. Кликните закладку Radiation Surface. Оставьте выбор Use Boundary 
Radiation Surfaces. Если вы хотите задать поверхность другого типа, то 
нужно использовать Use Custom Radiation Surface. 

 
6. Кликните  OK. Моностатическая сфера создана. 

 
       Задание сферы в бистатическом случае.  
 



  85

1. В дереве проекта, кликните правой кнопкой  на Radiation и из 
выплывающего меню кликните Insert Far Field Setup>Infinite Sphere. 
Появляется диалог Far Field Radiation Sphere Setup. 
 
2. Введите имя “Bistatic”. 

 
3. Установите величины Phi Start, Stop, и Step = 0. 

 
5. Установите Theta Start = 0,  Stop = 180 deg и Step = 1. 
 
6. Кликните  OK, чтобы закрыть диалог. 
 

Установка Bistatic появляется в разделе Radiate в дереве проекта.  
Зададим далее частоту 0.3 ГГц и запустим программу на расчет. 
 
Создание графика для бистатического  RCS. Чтобы задать параметры 
графика, выполните следующие действия: 
 
1. Нажмите правой кнопкой мыши на  Results в дереве проекта и выберите 
Create Far Fields Report>Rectangular Plot. Появится диалог New Report - 
New Traces. 
 
2. Оставьте в разделе Solution вариант выбора решения как Setup1: 
LastAdaptive. 
 
3. Чтобы вывести график  RCS, вы выбираете одну из геометрий в списке 
Geometry. Для этого графика выберите  Bistatic. 
 
4. В разделе Category, выберите Normalized Bistatic RCS. 
Этот выбор предполагает список Quantity чтобы показать NormRCS для 
Total, Phi, Theta, X, Y, и Z, с выбором Total Selected. 
 
5. Для этой функции, выберите dB. После этого выбора поле Y в разделе  
Trace показывает  db(NormRCSTotal).   
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Рис. 6.17. Выбор характеристики бистатического радиолокационного 

коэффициента отражения 
 
6. Откройте закладку Families и проверьте, что угол IWaveTheta=0. 
  
7.  Кликните New Report. Выводится график рис. 6.18. 
 

 
Рис.  6.18. График радиолокационного RCS для бистатического случая 

 
     По оси x этого графика – угол наблюдения. 

 
Создание графика для моностатического  RCS. Последовательность 
создания графика моностатического RCS аналогична описанной выше для 
бистатического случая. 
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1. Щелкните правой кнопкой мыши на значке Result в дереве проекта, и 
выберите Create Far Field Report>Rectangular Plot. Это открывает диалог 
характеристик (рис. 6.19). 
 
2.  В рамке Context, в разделе Geometry выберите Monostatic. 
 
3. В списке Category, выберите MonostaticRCS, а в списке  Quantity 
выберите MonostaticRCSTotal. 
 
5. Из списка Function, выберите dB. Тогда коэффициент отражения будет в  
dB. 
 
6. Выберите в поле X  характеристики IWaveTheta. 
7. Нажмите New Report. Это создает отчет и добавляет его в  дерево проекта. 
 

 
Рис. 6.19. Диалог для задания параметров графика в моностатическом 

случае 
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Рис. 6.20. Зависимость RCS от угла падения падающей плоской волны 
(моностатический режим) 

 
 На рис. 6.20 показан пример зависимости RCS как функции угла 
падения плоской волны. 


